Productivity Programs
Study Guide
Lesson 1: Common Features and Commands
1. Markus creates a document by using Microsoft® Office Word 2003 and saves it with the name Office.doc.

Which of the following components of Word 2003 will display the document name?

2. Cornelia uses Microsoft Office Excel® 2003 to create a worksheet that contains the estimated costs of her business project. She wants to update certain costs.

Which component of Excel 2003 will display the changes in the worksheet?

3. Stephan creates a business presentation by using Microsoft Office PowerPoint® 2003. He saves it with the name Presentation.ppt. Stephan opens the file to make some changes, and he wants to save it with a different name.

What commands on the File menu will Stephan use to save the file with a different name?

4. Nina uses Office Excel 2003 to create a work plan for her team. She wants to print the plan and discuss it with the team members in a meeting.

Which  menus will Nina use to print the plan?

5. You use Office Word 2003 to create a business document. You copy text from another document and want to add it to your business document.

Which commands on the Edit menu will you use for this?

6. Ewa creates a table by using Office Word 2003 to record some data. She wants to increase the size of the text in the table to make it more readable.

Which command on the Format menu will Ewa use to change the size of the text in the table?

7. You use Office Word 2003 to write an essay about uses of computers. After typing the document, you notice that a few words have a red wavy underline as shown in the exhibit.

Using the mouse, which action will you perform to view the shortcut menu for the underlined words?

8. You want to send an e-mail message to your friend to describe your meeting with Michal. However, you incorrectly type the name as Michael.

Where will you place the insertion point if you want to use the DELETE key to remove the letter e in the name Michael?

9. You want to access your MSN® Hotmail® account to check e-mail messages. The characters in your password are in upper case.

Which key will you press on the keyboard to type the password correctly in upper case?

10. You create a document in which you forget to include an important line in a paragraph. When you type the missing text, you begin to overwrite the existing text.

Which key do you press on the keyboard to ensure that the new text does not overwrite the existing text in the paragraph?

11. You create a business presentation by using Office PowerPoint ® 2003.

Which key will you use as a shortcut to display a slide show in PowerPoint 2003?

12. You are at the tenth page of a 20-page document. You need to make changes on the last page of the document.

Which key will you use in combination with CTRL to move to the bottom of the last page?

13. Peter wants to protect a confidential document by using a password. He wants to use an asterisk and an ampersand symbol in his password.

Which of the following keys does he press in combination with the number keys to correctly type the symbols in his password?

14. You create a document by using Office Word 2003. You need to enter the copyright symbol in this document.

Which key combination will you use to add the copyright symbol?

Lesson2: Word Processors

15. Anna is learning how to use a word processor. She wants to know the various tasks that she can perform by using this program.

List four  options that will answer her question? 
16. Your friend sees you working on Microsoft® Office Word 2003. He wants to know how to start this program.

Arrange the steps in the following list in the order in which you will perform them to start Word. 
17. Waleed creates a 100-page document. He wants to review the document from the beginning. He does not want to scroll up, but he wants to reach the beginning of the document by using the shortest method.

Which of the following keys will he use?

18. Christa makes a list of the guests she wants to invite to her daughter's wedding. She types the guest names and contact details in a document in Office Word 2003. She wants to know how many guests are on the list.

Which of the following features will help Christa track the number of guests while she makes the list?

19. Your friend wants to move text from the first paragraph of an article to the last paragraph by using the quickest method.

Which of the following options will help him do this?
20. Tony creates a table by using Office Word 2003. He wants to shade some cells in a row. He selects the cells and now wants to know how to shade them.

List the steps in the order in which Tony will perform them to shade the cells. 
21.  Jim wants to insert the logo of his company at the top of a document in Office Word 2003. The logo is saved in the My Pictures folder.

List he steps in order in which Jim will perform to insert the logo from the My Pictures folder. 
22. Karim uses Word 2003 to create a table that lists his expenses for January and February, as shown in the exhibit. He also wants to include his transportation expenses for January and February.

What will he do to include in the table the information about his transportation expenses?
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23. Isabel wants to write an essay in Spanish by using Office Word 2003. She wants to use the language tools for Spanish, such as the spelling checker that Word 2003 provides.

Which menu will she use to set the language to Spanish so that she can use the language tools for Spanish?

24. Daniela creates a document by using Office Word 2003. She uses the Spelling and Grammar tool to detect a misspelled word.

What option will Daniela use to correct the spelling of this word throughout the document?

25. Your friend wants to know about the AutoCorrect feature of Word 2003.

What will you tell her about the AutoCorrect feature?

26. Barbara wants to create a newsletter. She needs a program that provides several newsletter templates.

Which of the following programs will meet her needs?

27. David wants to know the benefits of desktop publishing programs.

List two  benefits desktop publishing programs provide? 
Lesson 3: Spreadsheets

28. Syed wants to know how to properly refer to the intersection of a row and a column in a spreadsheet.

Which of the following options answers his question?

29. Richard creates his monthly budget on a worksheet in Microsoft® Office Excel® 2003. He enters data in the worksheet.  What is the collection of cells containing the data called? 
30. Charlotte creates her expense sheet for the month, as shown in the exhibit.

Which column will she use to enter the amount spent on fuel?
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31. Your friend sees you working in Excel 2003 and wants to know how to start this program.

Arrange the steps in the order in which you will perform them to start Excel. 
32. Oliver plans to buy some household items. He lists all the household items and their expected prices in a worksheet in Excel 2003. He wants to sort all of the items by price, in ascending order.

Arrange the steps in the order in which Oliver will perform them to sort the items in the budget. 
33. John creates budget sheets for his project by using Office Excel 2003. He wants to replace the name of the current budget sheet with another name.

Arrange the steps in the order in which John will perform them to rename the worksheet. 
34. Alexander lends some money to Niraj. Alexander maintains a worksheet that lists the amount and the date when he lent money to Niraj. He wants to calculate the total amount of money he lent to Niraj. 

Which of the following toolbar buttons will Alexander click?

35. Erik receives his report card and wants to calculate his average marks. Identify the formula that Erik will use to calculate the average.

36. Vladimir borrows some money from Victor and then returns some of the amount to Victor the next day. Vladimir wants to know how much money he still owes to Victor. Which of the following formulas will Vladimir use?

37. David wants to copy all the files from his office computer to his laptop.  David enters the formula in a cell to calculate this sum.  Arrange the steps in the order in which David will perform them.
38. David uses Office Excel 2003 to calculate his average marks. He enters a formula in cell B5 to calculate the average based on the values in cells B2 to B4. David realizes that he entered his Science score as 67 instead of 69.  What will cell B5 display if he changes the value in cell B4 to 69?

39. Dina plans her budget. She wants to know what part of the total expenses she spent on groceries last month. She uses a spreadsheet and wants to make a chart to depict the portion spent on the groceries.

Which of the following charts will meet her needs?

40. Marko uses Excel 2003 to create a budget sheet for the total expenses that he spends on household items. He wants to view the data in a graph.  Which tool will he use to represent the data through a graph?

41. Patrik wants to show his household expenses through a pie chart. He wants to know the method to insert a pie chart in a worksheet in Excel 2003.  Arrange the steps in the sequence that will help Patrik to insert the chart. 
Lesson 4: Presentation Programs

42. Your friend sees you working on a presentation program. She wants to know about the features of this program.  List two features of presentation programs.
43. David uses Microsoft® Office PowerPoint® 2003 to create a presentation. He wants to add more slides to the presentation.  Which menu will he use to add slides to the presentation?
44. Carol is learning to create a presentation by using PowerPoint 2003. She wants to know how to add display effects on various slides of the presentation. Which option will you suggest to her?

 45. Pia creates a presentation by using PowerPoint. The slides in the presentation must contain a title, a bulleted list, and a diagram.  Which menu options will she select to do this?

46. You create a presentation by using Office PowerPoint 2003. You open the Insert menu to add a sound file to a slide.  Arrange the steps in the order in which you will perform them to add a sound file to the slide. 
47. You create a presentation by using PowerPoint.  Which toolbar will you use to add geometric shapes to the presentation?

48. Laura opens a presentation that she creates by using PowerPoint 2003. She wants to manually set timings for a slide show. Therefore, she wants to view the slides in the presentation as thumbnails.  What views will Laura choose?

49. Stella uses PowerPoint to create a presentation about the performance of her class. In the presentation, she wants to show a comparison between the assessment scores of her class in the current year and the previous year.  Which object will Stella add to the presentation to display the comparison?

50. You use PowerPoint 2003 to prepare a presentation about the quarterly performance of your organization across various regions. However, you want to change the Line chart to a Column chart. To do this, you double-click the chart to display the Chart menu.  Which Chart menu commands will you use to change the Line chart to a Column chart?

51. You create a presentation by using PowerPoint.. You need to print the presentation to take it home.

Which option will you select in the Print box to ensure that the examples are also printed?

Graphic


52. Larry prepares a presentation by using PowerPoint 2003. He needs to print the presentation to keep the key points handy. He wants an overview of the text in the slides, and he does not want to print the graphics.

Which of the following formats will Larry select in the Print box to print the presentation?

Lesson 5: Databases

53. Paula manages the recruitments for A. Datum Corporation. The company hires 500 employees. Paula needs to store on her computer the personal details, compensation structure, and insurance details for each employee.

Which of the following programs will Paula use?

54. Raman is a school administrator. He wants to store the records of all the students on his computer. He wants to maintain a database of all the records.  Which three objects can he create by using a database program? 
55. Michelle is a teacher at the School of Fine Art. She wants to start Microsoft® Office Access 2003 to update the student database by entering details about the students in her class.  Arrange the steps in the order in which Michelle will perform them to start Access 2003 on her computer. 
56. Ken creates a database in Access and saves it on his computer. He wants to open this database to view some details.  Arrange the steps in the order in which Ken will perform them to open the database. 
57. You create a table in the employee database of your company. You want the employee codes to be unique.

Which of the following actions will you perform on the Employee Code field in the database table?

58. Stephanie wants to create a new table in Access.  Which of the following options will she use?

59. Larry creates a table by using Access. He wants to set data types for the fields in the table.

In which of the following views will Larry open the table to set the data types?

60. Mark is a librarian at the School of Fine Art. By using Access 2003, he wants to create a database of the available books and their authors. Which menu will Mark use to create this database?

61. You work with Contoso, Ltd. Jesper is a newly hired manager in your company. You want to include his personal details in the employee database table.  What action will you perform to include Jesper's details in the table?

62. Karim is a shopkeeper. Every day he needs to check the quantity of available items in his shop. To easily maintain the records and get the updated inventory details, he creates a table in Office Access 2003.

Which data type will Karim use to enter the quantity of each item?

63. You create a table in Office Access 2003. You want to view the names in the table in alphabetical order.

Which action will you perform on the Name field?

64. You open a table in Access in Datasheet view. You want to filter the data in the table.   Which menu will you use to select the filter command?

65. Richard joins your team. You ask him to update the office database. He wants to know what a database query is.  What will you tell Richard?

66. Daniel needs to work with databases frequently. He wants to learn about database reports.

List two purposes can he use reports for?
